President’s Comments

At our last meeting
we found out that
several of our
members images
received awards
and honorable
mentions at the recent CACCA
competition. We applaud those
winners. We also passed out the
Honorable Mention and Award rib-
bons from our own Club competi-
tion (it took two of us to do that).
What a great feeling it was to know
that we had so many images and
that the images were of such ex-
cellent quality. Keep up the great
work!!!

Another impressive site is the
Club’s exhibit at the Arlington
Heights Memorial Library during
the month of October. We asked
our members to provide their fa-
vorite images framed and wired to
hang in this exhibit, and what a
terrific response we got. There
were 80 images presented to us
for this exhibit. This allowed us to
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“Beginning PhotoShop Elements” by Jerry

put up about 44 images for the first
two weeks and then change some
of them out and put up the others
for the second two weeks. We
stopped by the library on a couple
of occasions and found people en-
joying the images each time.

Our next exhibit is for two
months at the Elk Grove Library.
That will run for the months of No-
vember and December with an
open theme. For this exhibit, the
photos need not be framed, they
can be just matted. So please get
your favorite photos to Sue Far-
wick for this exhibit. We would like
to change the exhibit at month end
and it would be nice to have all
replacement photos for this exhibit.

We will keep you posted on the
upcoming exhibits for 2009. Pro-
viding these images for the public
to enjoy is one way the Club con-
tributes to our community, shows
the public what our members enjoy
and promotes the Club.

(continued on page 3)
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ACC meets at the Arlington Historical
Society, 110 W. Fremont, Arlington
Heights on the 1st and 3rd Wednesday of
the month, September through the 1st
Wednesday in June. Meetings start at

ACC Mailing Address:

126 E. Wing Street, Suite 242
Arlington Heights, IL 60004
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President’s Comments
(contd)

We thank all the many
volunteers that help Sue find
the places to exhibit and as-
sist her in setting up, change
and take down these exhibits
as needed. They do a great
job!

| trust that you have now
taken all your Fall photos and
have them on file. “What
next?” you ask. Winter is not
the time to be sitting indoors
when there are so many
wonderful things to photo-
graph. Yes, the season adds
more challenges, but it is still

http://www.outdooreyes.com/photo18.php3

fun. Now how do you shoot
winter scenes and what do
you look for? Well, a good
start is to put “winter photo
tips” into Google, you will
come up with numerous sites
to look at. A few are listed
below:

http://current.newsweek.com/budgettravel/2007/11/winter_photography-+tips.html

http://www.kodak.com/US/en/corp/maazine/tips/2001_01/

http://www.shutterbug.net/refreshercourse/outdoor tips/145/

http://www.takegreatpictures.com/winter_photo_tips.fci

It is a good idea to photo-
graph with a friend of two
when you out there in the
cold. If you need someone to
go shooting with, send an
email to our Yahoo! group
and see who is available. It
is best to shoot with a group
or, at a minimum, one other
person. Why? Winter sea-
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son brings us slippery terrain,
and the cold can cause frost-
bite. So it is best to have
someone with you that can
assist should you encounter
any of these problems. We
certainly don’t want anyone
to get any broken bones.

Do get out and enjoy the
photography of the season.

graphi iety of
75th Anniversary Conference

West Yellowstone, Montana
September 20 - 26, 2009

Through The Lens

Who knows, maybe next
summer we might have an
exhibit that will allow you to
show those winter photos
and help to keep everyone
cool during the dog days of
summer.

Bl and Cindy

Photographic

Society of
America
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November Programs
by Ken Olsen

November 3
Beginning Photoshop
Elements

Now that you've installed Photoshop Ele-
ments, what do you do with it? Jerry Hug will
explain from step 1 how to get started using
Photoshop Elements.

Jerry has been a photographer for 40 years.
His works have appeared in the Chicago Cul-
tural Center, the main Rotunda of the Thomp-
son State of lllinois Building in Chicago, Brick-
ton Gallery in Park Ridge, Bloomington Park
District Museum, William Koheline Gallery at
Oakton Community College, The Clearing in
Door County, Wisconsin, Johnson Galleries in
Santa Fe, New Mexico and the Des Plaines
History Center in Des Plaines, lllinois. His
works have been nationally published and are
included in various private collections on the
North Shore. Jerry has won various awards for
his photography throughout the greater Chi-
cago area. In 2001 he was commissioned to
produce a series of Historical Places in Maine
Township which was funded by a grant from the
State of lllinois. Jerry is president of the Chi-
cago Area Camera Clubs Association.

Jerry’s website: http://www.jerryhugphoto.com
Jerry’s blog: http://photounique.blogspot.com

WELCOME TO OUR NEW MEMBERS!

Say hello to the following new members of ACC:

Margaret Botchie
Michael Tomazevic
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November 19th
Discussions with Hank

Join nature photographer Hank Erdmann
for an evening of photo discussion and critique
of recent workshop images. If you haven't re-
cently been on a workshop with Hank feel free
to bring in any single image (prints please) that
you would like to have critiqued. Additionally,
Hank will be bringing some of his favorite Door
County images to showcase this wonderful
shooting location.

Hank Erdmann is a professional natural his-
tory photographer who resides in Will County,
lllinois. He has photographed throughout North
America, making the Midwest his primary geo-
graphic area of interest. A love of history, es-
pecially the maritime history of the Great Lakes,
kindles a special interest in the ports, shore-
lines, islands and natural areas of Lakes Michi-
gan and Superior and their surrounding envi-
rons. Hank is currently working on a book pro-
ject on the State of Michigan.

In addition to print sales Hank offers many
hands-on workshops. See Hank’s webpage at
www.hankphoto.com for a complete schedule
of workshops and samples of his work.
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Door County With Hank Erdmann

On October 11, 12, & 13,
Kent and his wife Janet, Jim
and his wife Bonnie, Ray, Ken
and Cindy spent 2-1/2 glori-
ous days in Door County pho-
tographing the areas light-
houses, beaches, and breath-
taking fall colors. Below are
some of the highlights

Day One:

Everyone met at Bluffside
Hotel, Sister Bay, Wisconsin.
First stop - Old Stage and
Wildwood Roads to shoot a
weathered barn and silo. We

27 2 oo B FENR (3 6 i P K
then headed to Gill’'s Rock.
Along the way we photo-
graphed a grove of birch trees
covered in fall color and an S
curve off of Cottage Row
Road. Peninsula State Park
was our next destination
where we stopped to photo-
graph the Eagle Bluff light-
house and sunset. Our day
finally ended with dinner at JJ
La Puerta Mexican Restau-
rant in Sister Bay. Once din-
ner was done we all headed
back to our hotels to down-
load our pictures, charge our
batteries and head to bed.
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by Cindy Kuffel

Day Two:

O n
t h e
beach at
7 :00
a.m. for
early
morning
sunrise
at New-
p ort
State
Park.
Stop for a rustic barn on the
side of the road. Breakfast at
The Viking in Ellison Bay and
then a visit to the Townline Art
Fair in Ephraim. We then
drove through Peninsula
State Park, first pulloff — Nel-
son’s Point to photograph a
fence and vines. Second pul-
loff — Mengleberg Lane to
photograph Blossom Burg
Cemetery.  Stop at Middle
Lane and Mengleberg Lane
for fall colors, Skyline Drive
Shanty Bay Overlook for fall
color, then over to Sven’s
Bluff for an S curve along the

lake and an open field of birch

and aspen trees. Dinner at
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the OId Post Office in
Ephraim for a traditional Door
County fish boil. Before din-
ner was served we were able
to watch the preparations,
see how our dinner was being
cooked, receive a story on
fish boils and laugh at some
really BAD jokes by our chef
Earl.  (Why do they cut the
heads off of sardines? So they
won't bite each other in the can.)
After dinner we all headed
back to our room to get ready
for another day.

Day Three:

6:00 a.m. car ride to Cana
Island
Lighthouse
for sun rise
and to
shoot dif-
ferent an- |
gles of the
lighthouse. S
Breakfast [§
at Bailey’s [
Harbor in
the Harbor Fish Market and
Grill. After breakfast we
headed for the nearby Ridges
Sanctuary to photograph Bai-
ley’s Harbor. We photo-
graphed a second lighthouse
— Ridges Lower Range Light-
house. We took a rest stop at
Bluffside, then headed back
to Ridges to photograph the
beautiful Fringed Gentians.
Off to White Fish Dunes Park
to walk the Clark Lake Trail
and photograph moss and fall

(continued on page 6)
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Door County With Hank Erdmann (cont’d)

colors. Next we stopped at
Cave Point County Park to
stretch our legs and tour the
area, especially the rock
cliffs along the lakefront.
Dinner was at the Mission
Grill (originally a Catholic
church) across the street
from the Bluffside Hotel.
After dinner some of us pho-
tographed the Mission Grill’s
church steeple silhouetted
by the moon, then off to
bed.

Day Four:

Now it's down to just
Ken, Hank and me. We re-

turned to the S-curve out-
side of Gills Rock to try to
c ap-
ture,
in dif-
ferent
light,
the S
curve,
hope-
fully
with
less
traffic.
Then we headed back to
Sister Bay for breakfast at
the famous Al Johnson’s
Restaurant (the place with
the goats eating on the

roof). After breakfast we bid
Hank a fond farewell and
started for home.

Special Note: Everyone
should try going on an out-
ing and/or a photo tour, the
knowledge we gained from
Hank and each other was
very useful. Hank went out
of his way to spend as much
time with each of us, even
sharing different pieces of
his equipment with us. We
exchanged ideas, learned
about the local Door County
areas and had a wide vari-
ety of fantastic food.
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HAPPY BIRTHDAY!

Cathie Berner

Bill Kruser
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November 22
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SOMEONE YOU SHOULD KNOW

Joanne Trahanas

Born: July 6, 1953.

Family: My daughter is 27 years old, a Doc-
tor of Physical Therapy, and someone of
whom | am most proud.

Hobbies: Photography, Scrapbooking, Writ-
ing (poetry & journaling), reading, movie
watching.

Favorite Book: : Prodigal Summer by Bar-
bara Kingsolver and the Harry Potter series
by J.K. Rowling.

Favorite Movie: Musical: Guys and Dolls;
Drama: Hotel Rwanda; Animated: Little Mer-
maid; Documentary: Born into Brothels.

Favorite Food:
and dolmades.

Greek food- spanakopita

This summer | was
looking out my friend’s
kitchen window when |
saw the baby birds be-
ing fed.
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Favorite Music: Folk, Easy Listening, and
Smooth Jazz.

Favorite Artist: Norman Rockwell, Georgia
O’Keefe.

Favorite Photographer/Photograph: Pat
Wadecki, Sam Abell, John Shaw, Ansel Ad-
ams.

Favorite Place to Shoot: Anywhere -- es-
pecially in nature.

How did you get interested in Photogra-
phy? When | was little my Uncle George
was into photography, and then my dear
friend and great family members purchased
my first digital camera and other equipment
for me.
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If you have not had the
time to read and view Photog-
rapher Annie Griffiths Belt’s
two books, you need to treat
yourself to the experience. A
Camera, Two Kids, and a
Camel: My Journey in Pho-
tographs and Last Stand:
America’s Virgin Lands are
two books that provide us
with unique views of our
world.

A Camera, Two Kids,
and a Camel: My Journey
in Photographs is a delight-
ful account of one of National
Geographic’s first female pho-
tographer’s journeys around
the world. For thirty years,
Annie Griffiths Belt packed
her family and equipment and
did everything possible to
maintain a “normal” life while
traveling on assignments to
various places. This book
documents, through her
beautiful images and narra-
tives, her experiences with
people from all over the world
and, in turn, their experiences
with Annie and her family.
Annie Griffiths Belt took the
time to become part of the
places to which she traveled.
The result is this book in
which Annie shares her un-
derstanding and love for the
people, their cultures, their
beliefs, and their worlds.
Throughout the book, her
photographs and words reach
out to us and bring the peo-
ples and countries closer to
us. Also engaging were the
stories of her children and the
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Annie Griffiths Belt

by Joanne Trahanas

many connections they made
to so many people in the
world and the impact of their
travels on their current adult
lives. The most influential
thing | took away from my in-
teraction with this book and
the art of Annie Griffiths Belt,
was to not just go somewhere
and shoot pictures, but rather
go somewhere and immerse
yourself into the worlds that
you visit and the culture of the
people you encounter, so that
the pictures are extensions of
those intimate connections.

Annie’s second book,
Last Stand: America’s Vir-
gin Lands is a joint effort with
author Barbara Kingsolver.
Once again, eloquent words,
photographs and hand-tinted
infrared pictures tell a re-
markable story. In this case,
the story is about what used
to be vast and is now rem-
nants of our wetlands, wood-
lands, coasts, grasslands,
and drylands. This joint effort
is one that calls to us to be-
come conservationists with
the likes of Henry David Tho-
reau, Aldo Leopold, John Muir
and more. It is a reminder
that long ago, days and sea-
sons were not measured by
how many traveling sports
games one may have to at-
tend, or the announcement of
the latest Apple technology, or
the opening of yet another
strip mall. Rather, the days
and seasons were marked by
natural happenings such as
the first day when maple sap

Through The Lens

runs, or jumping into icy pond
water just after winter’s end,
or running through open fields
only to find a baby animal’s
nest Somewhere, somehow,
between then and now, we
decided that everything on
earth was ours to use and
abuse, so we now have to
travel long and far to capture
open spaces and the natural
order it might supply. This
book takes us on a different
kind of journey - one that re-
minds us that we do not have
much left of our “virgin lands”
and that we need to be de-
fenders of what is left. As one
of our great conservations,
John Muir stated: “As soon
as we take one thing by itself,
we find it hitched to every-
thing in the universe.” So we
need to honor what is left of
those “one things” and maybe
some of our natural order will
be restored. What | also took
away from this book experi-
ence, was the importance that
a photographer and author
can play in bringing attention
to issues such as our virgin
lands, global warming, and
animal endangerment.
Through the art of photogra-
phy we can remind people
that we are part of a much
bigger, interconnected world
that needs us to defend it
from those who see it only in
terms of greed and profit.

So make vyourself com-
fortable and take the journeys
with Annie Griffiths Belt.
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Arlington Heights Memorial Library Display
by Cindy Kuffel

COME ONE, COME ALL TO SEE
ARLINGTON CAMERA CLUB’S PHOTO DISPLAY

October 2008 proved to be an exciting
month for the camera club. With much antici-
pation we unveiled our month-long photo dis-
play (which had been in the works for three
years). We had a total of 86 outstanding pho-
tos. Unfortunately, we were not able to fit all 86
photos on the display at one time, so for two

weeks we displayed the first 44 photos, then
changed out the display to show the other 42
photos. The response from the library (and
everyone who viewed these pictures) has been
VERY positive. Great job everyone, and than
you for your participation and help.
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ACC Competition Results -- October 2008

Slides

Diana Jacobson
Donna Thomas

Sam Krizan

Diana Jacobson

Small Color - Class B
Chris Solum

Norm Plummer

Chris Solum

Joanne Trahanas
Small Color - Class A
James Roberts
Marlene Jones
Barbara Silvers
Nathan Silvers
Marlene Jones

Small Color - Class AA
Kent Wilson

Kent Wilson

Jane Maio

Randy Vicek

Large Color - Class B, A & AA
Nathan Silvers

Ken Olsen

Kent Wilson

Barbara Silvers

Dead Horse Point
Summer’s Beauty
Bite Me

Hunt’s Mesa Morning

You Think You Paid to See Me?
Making Music
Goddess of Grapes

Deer Portrait

Mating Leopards
Determination
Messenger Woods
And the Winner Is

In the Mist

Sitting Pretty
Bleeding Heart
Lions on the Door

Silky Falls

Kapeli Ola Falls (AA)
Autumn at Matthessien (AA)
Sunset Over the Badlands (AA)

Water Lily (A)

21

21

21

21

22

21

21

20

22

21

23

21

21

23

23

21

21

24

23

23

22

AW

AW

HM

HM

AW

AW

HM

HM

AW

AW

HM

HM

HM

AW

AW

AW

HM

AW

AW

AW

AW

- SOM

- POM

(continued on page 6)
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ACC October Competition Results (cont’d)

Large Color Prints (cont’d)

Nora Liu

Ken Olsen

Kent Wilson

Diana Jacobson

Norm Plummer

Small Monochrome - Class B, A & AA
Jane Maio

Walter Hoffman

Barbara Silvers

Ken Olsen

Large Monochrome - Class B, A
Nora Liu

Nancy St. Clair

November 2008

Light Bouquet (A) 23 HM
Dead Horse Canyon (AA) 22 HM
Dining on Dragons (AA) 22 HM
Mount Robson (AA) 22 HM
Quiet Time (A) 21 HM
Lone Reflection (A) 22 AW - POM
River Rescue (A) 22 AW
Dragon Fly (B) 21 HM
Forlorn (AA) 21 HM
The Tender Trap (A) 22 AW - POM
World War Il Memorial 21 HM

“By temperament | am not unduly excitable and certainly
not trigger-happy. | think twice before | shoot and very
often do not shoot at all.”

Bill Brandt

“One of these days, I'm going to publish a book of all the
pictures | did not take. It is going to be a huge hit.”

Rene Burri

“Photography is like fishing. You go out in the morning
with no idea of what the trip will bring. Sometimes luck is
on your side and all your crab pots are full of prime Lob-
sters. Other times you get nothing.”

Bob Croxford
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CACCA Competition Results -- October 2008

Slides

Diana Jacobson
Donna Thomas
Bill Ditman

Sam Krizan
Large Monochrome
Walter Hoffman
Nora Liu

Nancy St. Clair
Small Monochrome
Jane Maio
Walter Hoffman
Ken Olsen
Nancy St. Clair
Small Color
James Roberts
Kent Wilson
Chris Solum
Barbara Silvers
Large Color
Kent Wilson
Randy Vicek
Nate Silvers

Ken Olsen
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Hunt’s Mesa Morning
Posing Bison
Big Sur Light

The Scream

St. Peter’s
Brooding

Rapid Falls

Lone Reflection
River Rescue
Forlorn

Black Kat

Mating Leopards
Bleeding Heart
You Think You Paid to See Me?

Messenger Woods

Sunset Over Badlands
Blue Pools
Kapeli Ola Falls

Dead Horse Canyon

Through The Lens

21

21

21

21

21

20

23

22

21

20

23

23

22

22

25

24

23

23

AW

AW

AW

AW

HM

HM

HM
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The

igital Corner

Using Photoshop to Enhance Copyright Protection

Registering  works with
the U.S. Copyright Office
provides significant provides
significant advantages when
seeking redress against in-
fringers. Registration of
groups of photographs is
neither expensive nor diffi-
cult and can e done quickly
and with little effort if steps
are taken to incorporate
copyright issues into the
normal process of creating
the deposit of images that is
required when you submit
your registration application
and can also enhance the
level of copyright protection
by embedding a copyright
notice into the metadata of
your image files.

The first action described
below saves the file in the
current directory, prepares a
low-resolution copy, stores
the low-resolution copy in a
separate designated folder,
and then closes the image
file. The low-resolution im-
ages can then be copies
from the folder onto a CD or
DVD for inclusion with the
application. If you want, you
can modify this action to
create actions that a copy
the low-resolution files to
different destination folders
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by Bert P. Krages Il

for published and unpub-
lished images.

The second action em-
beds a copyright notice and
related information for un-
published images into the
IPTC space of a digital im-
age file. IPTC is an interna-
tionally recognized protocol
that enables text information
to be embedded in the im-
age for future reference. Us-
ing this action will also
cause Photoshop to display
a copyright symbol on the
title bar of images that are
opened in Photoshop. If you
want, you can modify this
action so that it can be used
for published images.

The Copyright Dump Ac-
tion

To create a Copyright Dump
action:

1. Create a directory folder
called “Copyright Dump”
or similar name. This is
the directory in which
you will store the low-
resolution images pro-
duced by the action.
Wen you are ready to
submit the application to
register the copyrights to

Through The Lens

the images, you can
copy the images in the
folder onto a CD or DVD.

Open an image for which
you will want to register
the copyright.

Go to the View menu
and click to make the
“Actions” palette appear
on the monitor.

Click on the “New Action”
symbol which is the
square-within-square
icon at the bottom of the
palette.

Enter “Copyright Dump”
in the space for “Name”
and click on “Record.”

Click onto the “File”
menu and then click onto
“Save.” This will save
the image in its current
file folder.

Click on the “Image”
menu and click on “Im-
age Size.”

Click on “Auto Resolu-
tion” and enter “75 lines
per inch” in the space for
“Screen.”

(continued on page 14)
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Using Photoshop to Enhance Copyright Protection (cont’d)

9. Click OK and then click
OK to exit the Image Size
palette. The image size
should now be smaller.

10. Click onto the “File”
menu and then click onto
“Save As.” Make the file
type is either JPEG,
TIFF, or GIF. Change the
folder to “Copyright
Dump” and click “Save.”

11. Click on the square at the
bottom of the action pal-
ette to stop recording the
action.

To use the Action

Each time you are done
processing an image in Pho-
toshop, play the action and
Photoshop will automatically
save the file into its current
directory and then create
and store a low-resolution
copy into the Copyright
Dump folder. When you are
ready to submit the registra-
tion application to the U.S.
Copyright Office, you can
copy the entire Copyright
Dump folder onto a CD or
DVD to prepare the required
deposit. Afterwards, you
should copy the files to an-
other CD or DVD for your
records and delete all the
images from the folder. Al-
ternatively, if you want to
keep the record of the regis-
tered images on your hard
drive, you can rename the
Copyright Dump directory to
correspond to the title used

November 2008

on the registration applica-
tion (e.g., Images, October to
December 2006) and create
a new folder called “Copy-
right Dump.”

The Copyright Notice Ac-
tion

To create the action:

1. Open an image for which
you want to insert the
copyright notice.

2. Go to the View menu and
click on “Actions” to
make the Actions palette
appear on the monitor.

3. Click on the “New Action”
symbol which is the
square-within-a-square
shaped icon at the bot-
tom of the palette.

4. Enter “Copyright Notice”
in the space for “Name”
and click on “Record.”

5. Click on the “File” menu
and then click on the
“File Info.”

6. Enter your name into the
space for “Author,” click
on the space for “Copy-
right Status” and indicate
“Copyrighted Work.”

7. In the space for “Cap-
tion,” enter “unpublished
work Alt-0169” from the
numbers keypad if using
a PC or “unpublished
work Option-g” if using
Mac. Append this phrase
with your name and the

Through The Lens

year of creation so that
the entire phrase reads
something like “unpub-
lished work © Your Name
2005.” Copy and paste
this information into the
space of “Copyright No-
tice” as well. You want to
use the caption space
because this is where
some other programs
read the basic file infor-
mation. It is a good idea
to include your address
and contact information
into the caption space.

8. Click on “OK” and then
click on the square at the
bottom of the Action pal-
ette to stop recording the
action.

Note: You can create a
separate action to be used
for published images. To do
this, omit the phrase “unpub-
lished work” in step 7 and
insert the year of first publi-
cation.

To use the action:

Each time you are fin-
ished with processing an im-
age in Photoshop, play the
action and Photoshop will
automatically insert the tex-
tual information into the IPTC
space.

© 2006 Bert P. Krages 11
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ACC Calendar

September 3, 2008

Lou Nettlehorst -- Designing your photographs

Want to make more interesting photographs? Learn about designing or making images,
not just taking them. This class will enhance your awareness of subjects, teach you about
seeing differently and help you compose photographs using the building blocks of visual
design.

September 17, 2008

Pat Wadecki -- Quest for Impact

How subject matter, composition, choice of lenses and filters, and chasing the light contrib-
ute to bagging that trophy shot, and how a photographer’s personal perspective of an often
photographed area can turn that shot into one full of impact.

October 1, 2008

Competition -- Open to all paid members. Please arrive early so that your entries can be
registered. Competition begins at 7:15.

October 15, 2008

Critique Workshop -- We will discuss photos from the October competition with an eye to-
ward improving them or learning why they work.

November 5, 2008

Jerry Hug -- Beginning Photoshop Elements

Now that you’ve installed Photoshop Elements, what do you do with it? Jerry Hug
will explain how to get started using Photoshop Elements.

November 19, 2008

Hank Erdmann -- Nature photographer and workshop leader Hank Erdmann will join
us to discuss images taken on our recent workshops. If you haven’t recently been on
a workshop with Hank, feel free to bring in any single image (prints please) that you
would like to have critiqued. Additionally, Hank will be bringing some of his favorite
Door County images to showcase this wonderful shooting location.

December 3, 2008

Competition -- Open to all paid members. Please arrive early so that your entries can be
registered. Competition begins at 7:15.

December 17, 2008

Critique Workshop -- We will discuss photos from the December competition with an eye
toward improving them or learning why they work. Holiday Party Too!

January 7, 2009

Digital Competition. We will be holding our first digital competition. Details in January

newsletter.

January 21, 2009

Bo Yuan from Imaging Luminary -- Demonstration of HDR and Tone-Mapping

TBA

February 4, 2009

Competition -- Open to all paid members. Please arrive early so that your entries can be
registered. Competition begins at 7:15.

February 18, 2009

CACCA Digital Competition -- ACC will host the monthly CACCA digital competition.

March 4, 2009

TBA

March 18, 2009

Fred Drury -- Color Management

April 1, 2009 Competition -- Open to all paid members. Please arrive early so that your entries can be
registered. Competition begins at 7:15.

April 15, 2009 Critique Workshop -- We will discuss photos from the April competition with an eye toward
improving them or learning why they work.

May 6, 2009 TBA

May 20, 2009 TBA

June 3, 2009 End of Year Competition and Election of Officers
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Dead Horse Canyon
by Ken Olsen

Light Bouquet Mt. Robson
by Nora Liu by Diana Jacobson

You Think You Paid to See Me?
by Chris Solum

Deer Portrait
by Joanne Trahanas

Determination
by Marlene Jones

unt’s Mesa Morning
Making Music by Diana Jacobson
by Norm Plummer

Autumn In Motion
by Ken Olsen

Sunset Over The Badlands
by Kent Wilson
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